PiCUS Sonic Tomograph
Version 3
Hardware Manual

Refers to PiCUS 3 Version:

PiCUS 3 - Hardware: 22, 23
PiCUS 3 – Firmware version: 20, 21
PiCUS PC Program Q73.2, Q74 or higher
Manual version: February 2ed 2017

argus electronic gmbh
Erich-Schlesinger-Straße 49d
18059 Rostock
Germany
www.argus-electronic.de
Content

1 Abbreviations ......................................................................................................................... 4
2 Field of application / disclaimer ........................................................................................... 4
3 Get started............................................................................................................................... 5
  3.1 General hints ....................................................................................................................... 5
  3.2 Hardware ............................................................................................................................ 5
    3.2.1 PiCUS 3 – Main control unit ....................................................................................... 5
    3.2.2 Sensor cable loom .......................................................................................................... 6
    3.2.3 Electronic radio hammer with display (PRHD) .............................................................. 7
  3.3 User Controls ...................................................................................................................... 8
  3.4 General settings .................................................................................................................. 8
4 PiCUS 3 operation without PC .............................................................................................. 9
  4.1 General workflow ............................................................................................................... 9
  4.2 Recording the geometry of the measuring level ................................................................ 10
    4.2.1 Circular geometries ..................................................................................................... 10
    4.2.2 Free shapes geometry with calliper ............................................................................. 10
  4.3 Tree Data ........................................................................................................................... 12
  4.4 Installing the PiCUS 3 on the tree ..................................................................................... 14
  4.5 Sonic measurement ............................................................................................................ 15
  4.6 How to check data ............................................................................................................. 16
  4.7 Calculation of the tomogram on the PiCUS 3 .................................................................. 17
  4.8 Saving data to the internal SD card of the PiCUS 3 ........................................................ 17
  4.9 Download data files to PC ................................................................................................ 18
5 PiCUS 3 operation with PC .................................................................................................... 19
  5.1 Installation of the PiCUS PC Software ............................................................................... 19
  5.2 Configuration of the PC software ...................................................................................... 19
  5.3 Sonic scan with PiCUS PC program Q73 ......................................................................... 21
  5.4 Read GPS signal from PiCUS 3 ....................................................................................... 22
6 Charging PiCUS 3 .................................................................................................................. 23
7 Advanced information ............................................................................................................ 24
  7.1 3-Point measurements ....................................................................................................... 24
  7.2 Radio Hammer Operation .................................................................................................. 25
  7.3 Download tree names list to PiCUS 3 .............................................................................. 26
  7.4 Exporting geometry and tree data to TreeTronic 3 ........................................................... 27
8 Firmware updates of the PiCUS 3 ........................................................................................ 28
  8.1 How to check the firmware version of the PiCUS 3 ........................................................ 28
  8.2 Update of the firmware of the PiCUS 3 display ................................................................. 29
1 Abbreviations

BT Bluetooth.

MP Measuring point. Each nail that used for the sonic scan is a measuring point.

m/sec Unit of the speed in “meter per second”

PRHD PiCUS Radio Hammer with Display. Works only with PiCUS 3.

USB Universal Serial Bus.

UTC Universal Time Coordinated. This time is delivered by the GPS signal. For most common purposes, UTC is synonymous with Greenwich Mean Time (GMT).

V Volt

2 Field of application / disclaimer

The PiCUS® Sonic Tomograph was developed to examine living trees. Using the device inappropriately can lead to damage, both to the unit and to the tree itself.

Although every effort has been undertaken to present the results of measurements as comprehensibly as possible, interpretations of readings do require qualified technical expertise. The user bears the sole responsibility for all conclusions made about the status of any tree examined. Neither the manufacturer nor the distributor of the PiCUS® Sonic Tomograph can be held liable for any decisions made based on measurements made with the PiCUS®.

We strongly recommend attending a training course conducted by the distributor or by a certified institution in your country. A list of such institutions can be found at the argus electronic web site.

The PiCUS® Sonic Tomograph detects differences in the ability of the wood to transmit sound waves. It cannot identify the specific reasons for such differences. This means the instrument is not able to identify the exact type of damage: it may be decay, hollowness, cracks, or something else.

Before taking any action or deciding to fell a tree, please be sure to identify the underlying reason for the defect you see in the tomogram.

All technical information is subject to change without notice.
3 Get started

3.1 General hints

The PiCUS 3 can be operated with or without a Windows - PC. Chapter “PiCUS 3 operation without PC” describes how to use the PiCUS 3 in stand-alone mode. Chapter “PiCUS 3 operation with PC” describes how to control the PiCUS 3 using the PiCUS Q73 Windows PC program.

The functionality of the device in either PC - or stand-alone mode is very similar. The only difference is that the number of measuring points (MP) in stand-alone mode is limited to 24. The maximal number of MP in the PC program is 100.

Previous versions of the PiCUS PC program do not work with the PiCUS 3 hardware!

Hint: Make sure both hammer and PiCUS are turned off when cables are plugged.

3.2 Hardware

3.2.1 PiCUS 3 – Main control unit

- Socket (A) for cable loom sensors 1 to 6

- Battery compartment (do not open)

- Socket (C) for hammer cable

- Socket (B) for cable loom sensors 7 to 12

- Twist and Push button (S)

- Socket (E) for charger

- Socket (D) for USB cable (Connection to PC)
3.2.2 Sensor cable loom

How to connect the sensor cable looms to the main control unit.

Red dot needs to meet red dot. Sensor cable loom 7-12 correctly plugged in socket (B)

How to disconnect sensor cable looms

Always handle the connector at the grip! This is important to unlock the connector.

NEVER pull the cable loom on the cable itself!
3.2.3  Electronic radio hammer with display (PRHD)

*How to connect the hammer cable*

*Hint: Make sure both hammer and PiCUS are turned off when cables are plugged.*

Socket “C” for hammer cable. Pay attention to the red dots.

*How to disconnect the hammer cable*

Use thumb to unlock the connector when pulling the hammer cable off the socket!

Always handle the connectors at the grip! This is important to unlock the connector. When pulling out the right-angled connector of the hammer cable use your thumb to operate the unlock mechanism.

**Attention:** NEVER pull the cable on the cable itself!
3.3 User Controls
The PiCUS 3 is equipped with three buttons that are used for navigation through the menu and typing in data.

“OK” Button: Push the “twist and push” button. Used to go into a (sub) menu or confirm a value.

“ESC” Button: Used to leave a menu when all settings are done.

“+-” Twist wheel: Used to scroll through menus and alter values.

“ON/OFF” Button: Hold the button pressed for 3 seconds to turn the PiCUS 3 ON or OFF.

3.4 General settings
The following setting should be done before using the PiCUS 3.

1. **Set language**. Languages English, German, French and Polish are available.
   
   *PiCUS 3 main menu* → “Configuration” → “Language”

2. **Set display Brightness**. Adjust to your requirements. Bear in mind: less brightness – less power consumption.
   
   *PiCUS 3 main menu* → “Configuration” → “Display Brightness”

3. **Set PiCUS calliper Bluetooth address**. Each calliper has a unique Bluetooth address (ID). This ID can be found when in the Bluetooth manager of the PC when the PiCUS calliper is connected to that PC.
   
   *PiCUS 3 main menu* → “Configuration” → “Calliper Address”

   In the PC the Bluetooth address can be retrieved in the folder “devices and printers”. Right click on the calliper icon and click on “Properties”. In the properties window click on “Bluetooth”. The Bluetooth ID looks like this: 00:08:A5:42:1B:CC.

4. **Set power off time**. The PiCUS 3 will turn off after the specified time to safe power.
   
   *PiCUS 3 main menu* → “Configuration” → “Configuration” → “Auto Power OFF”

5. **Set number of sensors**. PiCUS 3 can be operated with one or two sensor cable looms. Enter “6” if one sensor cable loom is available. Enter “12” when two sensor cable looms can be used.
   
   *PiCUS 3 main menu* → “Configuration” → “Number of Sensors”

6. **GPS Timezone**. This setting is used to adjust to the local time in relation the GPS time obtained from the integrated GPS receiver.
   
   *PiCUS 3 main menu* → “Configuration” → “GPS Time Zone”

7. Download your individual “Treenames” file to the PiCUS 3. For details see chapter: “Download tree names list to PiCUS”
4 PiCUS 3 operation without PC

4.1 General workflow

In order to record a sonic tomogram of a tree the following steps need to be carried out:

1. Visual inspection to decide at which level the tomogram needs to be taken.
2. Depending on the visual inspection a 3-Point test (Chapter: 7.1 - 3-Point measurements) or “Point to Point” scan can be done to roughly check the quality of the tree. If this test shows bad wood properties it is recommended to do the full tomogram test. The “Point to point” test is NOT mandatory.

To continue with the tomography scan:

3. Selecting the positions of all MPs and tapping in all nails at those points.
4. Recording the geometry of the measuring level (positions of all MP).
5. Enter tree data such as tree name, number, height of measuring level etc. Measure tree height using the semi-automatic tree height functions of the PiCUS 3.
6. Installing the PiCUS 3 on the tree.
7. Performing the sonic scan by tapping at all MP with the PRHD.
8. Save the file on the internal SD card of the PiCUS 3.
9. Interpretation of the tomogram
10. Dismantling of the PiCUS 3, removing nails.
11. Upload data files to PC.

The next chapters describe the operation of the PiCUS 3 during the workflow shown above. To start a sonic scan using the PiCUS 3 in stand-alone mode turn on PiCUS 3 and choose menu “Sonic Tomogram”

The next step is to enter the geometry of the measuring level.

PiCUS 3 installation
4.2 Recording the geometry of the measuring level
There are two ways to record and enter the positions of the MPs:

- Assuming the tree’s circumference is a circle and entering the distances of all MP along the circumference
- Use triangulation method to measure positions of all MP accurately on any shape of trees

For more or less circular cross sections the measuring level can be depicted as a circle. However, in most cases the triangulation method (“Free Shapes”) yields better results.

4.2.1 Circular geometries
In the “Sonic Tomogram” menu of the PiCUS 3 select the menu

“Geo circle” The sub menus configure the circle and positions of MP along the circumference.

“Number of MP” Enter the number of MP here. The number of MP is the number of nails in the tree. It is NOT necessarily the number of sensors.

“Tree circumference” Enter the circumference in the unit millimetre [mm]. Wrap the measuring tap anti-clockwise around the measuring level. The zero mark is at MP 1.

“MP-Distances” Wrap the measuring tap anti-clockwise around the measuring level. The zero mark is at MP 1. Enter the position of each MP along the circumference. Example: nail 2 is at 25,7 cm. Type in line “MP1 -> MP2 [mm]”: 257.

“ESC” button: quit that menu.

4.2.2 Free shapes geometry with calliper
In the “Sonic Tomogram” menu of the PiCUS 3 select the menu

“Free Shape” The sub menus configure the free shape measuring.

“Number of MP” Enter the number of MP here. The number of MP is the number of nails in the tree. It is NOT necessarily the number of sensors.

“Base Points” Enter the number of base points (two or three) first. Select the base points afterwards.

“Free Shapes Calliper” Mechanical callipers or the PiCUS calliper can be used for the triangulation measurements. To work with a standard calliper (mechanical) choose menu “Using NO Callipers”
In order to work with the PiCUS Calliper turn on the Calliper now. When the calliper is flashing quickly after a couple of seconds select menu:

“Calliper is ON”

The PiCUS 3 starts to connect with the calliper. Once the connection is established the measuring commands are being sent to the calliper screen. The PiCUS 3 unit can be carried during the geometry measurement to avoid BT radio shadow of the tree.

If the BT connection is interrupted – because of large diameter tree and the calliper screen is frozen, then bring calliper and PiCUS in direct view and push “Enter” button on the TreeTronic 3 to re-send the lost command to the calliper.

Once all distances are measured by the calliper or typed in manually the outline of the tree is drawn. Click “Geometry OK” or “Revise” to accept or change geometry.

“MP1->MP7 [mm]: 0

Example: distances to measure with either PiCUS electronic calliper or with a different tool. The distance can be entered by hand (use the twist-button ‘C’) or via BT from calliper. If the distance was entered by hand in some cases the orientation is also required. Twist button ‘C’ to change orientation and OK to enter.

“Geometry OK”

Confirm geometry.

Note: this function quits the geometry measurement. If the Geometry function is called again all distances entered before are set to 0. Thus, all distances need to be entered again.

“Revise”

Alter all distances.

Note: If a value needs to be measured again (because a wrong value was taken or the BT connection was interrupted) set the value on the screen to “0” and push “OK” to re-send the command to the calliper.
4.3 Tree Data

“Tree Data”

Menu is used to enter tree details.

“Tree Species”

Choose botanical tree name from a list of 27 trees that have been downloaded from the PC. If the tree species is not in the list choose “_Not specified” or alter the list.

“Tree Height”

The tree height can be typed in (Unit [m]) when the height was measured with a different device. The PiCUS 3 has a semi-automatic function to measure tree height. Click on: “Measure height” to activate the measuring.

“Distance to Tree”

Enter distance of your location to the tree in meter [m]. Typically the distance should be 10 to 30 meter.

“Angle Tree Top”

measures the angle to the treetop. **Attention: do NOT aim to the outer branches. Try to point to the axis of the tree.**

“Angle Tree Base”

measure the angle to the tree base.
“Number” Enter the number of the tree according to your numbering system.

“N/E/S/W Alignment” Enter North-alignment of the MPs. Standard: MP 1 at North.

“Height of Meas. Level” Enter height of measuring level in [cm].
4.4 Installing the PiCUS 3 on the tree

When all data is entered the sensors and PiCUS 3 main unit need to be mounted to the tree. Use the blue strap to hold main unit and cable looms if the measuring level is higher than 30 cm. Put the number plates on all MP.

1. Place the PiCUS 3 main unit in-between MP 6 and 7.
2. Plug in the left sensor cable loom - sensors 1 to 6 - to the left socket A, named “1-6”.
   Plug in the right sensor cable loom - sensors seven to 12 - to the right socket B, named “7-12”.
3. Connect the angle-connector of the hammer cable to socket C (left lower corner). Connect the other straight-end connector to the grip of the hammer. Alternatively the hammer can be used wireless:
   In many (not all!) locations the cable-less radio connection will work.
4. Put all sensors on the nails. Do not allow the sensors to jump to the nails!

5. Type in the locations of all sensors by using the menu:

   “Sensor-MP Allocation” In this menu the current location of each sensor can be set. If the number of MP is smaller or equal to the number of sensors then no settings need to be done.

   “Sensor 1 -> MP 1” “Side by side” – setting. Selecting this function assigns sensor 1 to MP 1, sensor 2 to MP 2 and so on. The graphic shows “1S1” near MP 1, where the first “1” is the MP number and “S1” means “sensor 1”. If the tree has 13 MP or more then no sensor is assigned to MP 13.

   “1 . . 2 . . 3” “Evenly spaced” – setting. This function distributes the number of sensors evenly spaced around the circumference if the number of MP is an even multiple of the number of sensors.

   “->>” Pushing this button moves all sensors to the next logical position. Behaviour of that function depends on what method - “side by side” or “evenly spaced”- has been used before.

   “Sensor 1 -> MP 1,2,3..” In this menu the sensors can be assigned to any MP freely. Any sensor can be assigned to any MP. “S:0 ->MP1” means that NO sensor is assigned to MP1. “S:7 ->MP1” means that sensor 7 is assigned to MP1.

Attention: sonic data cannot be used if the MP-Sensors assignment is incorrect!

Example for using the sensor - MP allocation functions

Tree has 14 MP. PiCUS 3 has 12 sensors. Use “Sensor 1 -> MP 1” side by side setting. The first sensor-MP allocation (called “Position 1/2”) sets sensor 1 at MP 1 etc. MP 13 and 14 do not have sensors. When the first round of tapping is done go to “Sensor-MP Allocation” and click “->>” function to move sensor 1 to MP 13 and sensor 2 to MP 14. This is “Position 2/2”.

www.argus-electronic.de
Alternatively - if cable length allows – use “Sensor 1 -> MP 1,2,3..” function and disable sensors 1 to 10 by setting “S:0 ->MP1”, “S:0 ->MP2”, “S:0 ->MP3” etc. Assign sensor 11 to MP 13 by setting “S:11 ->MP13” and sensor 12 to MP 14 by setting “S:12 ->MP14”

**Note: the entire measurement is wrong if the sensor – MP allocation is incorrect!**

### 4.5 Sonic measurement

Before the actual scan can start make sure that all sensors are placed correctly on the nails. When sensor placement is done correctly the tapping can begin. Bear in mind that every time the sensors are moved the sensor-MP allocation table needs to be updated. An incorrect assignment will void all data. Select

1. “Sonic Tomogram” → “Measurement” to start the sonic measurement. The tapping screen is shown.
2. Activate the hammer by pushing either button (> 1 sec). The hammer display shows circling lines. Set tapping position: Push upper hammer button to count upwards or lower button to count downwards.
3. Take the sensor off and put the tapping pin of the hammer on that nail.
4. Tap on the tapping pin, 3 to 5 times. When five data sets have been recorded the LED in top left corner will show yellow light.
5. Check data quality by watching the bar graphs on the display. Traveltime of sonic waves is shown by the yellow bar graphs, velocity by the reds. Very high or low velocities may indicate MP-Sensor allocation errors or other problems.

![Sonic measurement diagram](image)

“MP”: MP number, tapping point is red
Yellow bars: travel time of sonic waves [µs]
Red bars: sonic velocity [m/sec]
The screen only shows data of the MP that have sensors attached.

“S”: Sensor number

6. Tap on all MP (with or without sensors associated).
7. If the number of MP exceeds the number of sensors then you need to move sensors to the open MPs, adjust sensor-MP allocation table and tap again on all MPs.

**Hint:** When using the wireless radio connection between hammer and main unit try to keep the distance between hammer antenna and cable loom as large as possible since the radio signal may interfere with the sonic scan. This can be done by holding the hammer upright.
In case you want to switch from radio-hammer connection to cable-hammer connection during a measurement because of unreliable radio connection please proceed as follow:

1. Wait until the hammer turns itself off!
2. Terminate the measuring window or leave the PC-connection window, depending on the operation mode.
3. Disconnect the hammer antenna from the hammer.
4. Connect the hammer cable to both hammer and PiCUS 3.
5. Re-enter the measuring window or re-start the “Sonic Tomogram PC” function.

4.6 How to check data
In order to load results of previous taps – the bar graphs - go to the sonic measurement window and scroll to the MP you want to see using the hammer buttons.

Once the screen shows the MP you want to see use the twist and push button (S) to scroll through the actual taps.

Note: Incorrect data can be overwritten by generating another 5 good values on that MP. This is because the ring-memory for the sound-speed data can only save 5 values. If the MP is tapped more often, then the old values are overwritten.
4.7 Calculation of the tomogram on the PiCUS 3
The tomogram is being calculated when the measuring function is terminated by pressing “ESC” and the program returns to “Sonic Tomogram” menu.

The tomogram shows the sonic velocity in 3 colours:
- Pink – represents slow velocities
- Green – medium velocities
- Brown – fast velocities

Pay attention to the “v-max” and “v-min” values shown. Velocities of more than 3000 m/sec hardly occur in trees.

The PiCUS 3 cuts off velocities larger than 5000 m/sec automatically.

Note: the tomogram shown on the PiCUS 3 screen is not as accurate as the tomogram of the same file on the PC. Due to limited resources not all of the calculation methods have been implemented.

4.8 Saving data to the internal SD card of the PiCUS 3
The PiCUS 3 can save up to 120 files. When 100 files are on the SD card a warning is shown. Files can still be saved.

To save data recorded go to file menu.

“Sonic Tomogram” → “File” → “Save all Data to File”

and push “OK” button.

The filename is created automatically using UTC time and date (from GPS unit). When the files are loaded to the PC the local time and date are added to the filename.

Other functions in the file menu:

“Clear Sonic Data” Deletes all sonic data of the tappings. All other data such as geometry, tree species, height etc. are not changed. This function can be used when a second scan of the same measuring (unchanged geometry) level needs to be done.

“Clear all Data” Deletes all data: sonic data, geometry and tree information.

“Load/Delete Files” Access to the file load and delete functions.

“Load File” Shows the content of the internal SD card. “Number of files” is the number of stored files. Scroll through the menu to select the file to load and push “OK” when done to load the file.

Attention: loading a file overwrites the current data (sonic, geometry and tree data)!

“Delete Files” Shows number of files on the SD card and offers to delete all of them at once. Push “OK”, enter “13” and push “OK” again to delete ALL files. Deleted files CANNOT be restored.
4.9 Download data files to PC

To download data files from the SD card of the PiCUS 3 to the PC proceed as follows:

1. Prepare the PiCUS 3 for data files upload by going to menu:

   PC program “Data to PC”.

   The PiCUS 3 now waits for the serial connection (either BT or USB) to the PC.

2. Start the PiCUS Q73 program on the PC. Make sure that the Q73 program is configured for PiCUS 3 operation.

   PC program “Configuration” → “PiCUS sonic Tomograph Hardware” → “PiCUS 3”

3. Make sure the COM port is selected correctly (BT or USB) in menu

   PC program “Configuration” → “Select COM port” → Tab “Port PiCUS”

4. Go to:

   PC program “PiCUS 3” → “Data Import”.

   The download window will open

5. PC program Open the COM port in the download window and select a valid path on the PC.

6. PC program Click “Import” button to start the data file download.

7. After downloading all files you are being asked to delete all files on the PiCUS 3. If you press yes then all files on the SD card of the PiCUS 3 are being deleted. Attention: deleted files cannot be restored!

Note: The files downloaded are renamed according to the local settings of the PC. The TreeTronic 3 derives the filenames from the GPS time and date. GPS time and date are always given UTC. The local time and date will differ from UTC. In order to keep track of files the PiCUS PC program calculates local time and date of the measuring file and adds this information (prefix “LT” – local time) to the filename. The local time information is derived from the time settings on the PC the program is running at.
5 PiCUS 3 operation with PC
This chapter shows basic steps that are needed to do a sonic scan using the PiCUS PC software. This function is only available in PiCUS Q73 or higher versions.

5.1 Installation of the PiCUS PC Software
To install the Q73 program the setup.exe must be executed in “Run as Administrator” mode. Right click the icon and choose from the drop down menu.

5.2 Configuration of the PC software
1. Configuration of the PiCUS PC Program
   PC program “Configuration” → “Hardware” → “PiCUS 3”
   This setting will only affect the measuring process. It does not affect the calculation. Thus, files of all PiCUS versions can be calculated using the “PiCUS 3” setting.

2. Enter “PiCUS 3” COM port
   PC program “Configuration” → “Select COM port” → Tab “Port PiCUS”
   Set PiCUS COM port, either USB or Bluetooth. Set Baud rate to 115200. Press “OK” to save the settings.
   Note: Install the USB cable between PiCUS and PC BEFORE you enter this window. The USB COM port is only visible when the PiCUS is connected to the PC prior to opening this window. The USB port of the PiCUS is shown in blue characters in the drop down menu.

   Leave options for “waiting time” and others unchanged.

   Attention: Every time the COM port is changed, for instance from Bluetooth to USB, the port setting in this window needs to be updated.
3. Test COM connection
   In order to check the COM connection between PiCUS 3 and PC turn on the PiCUS 3. Go to menu:

   PiCUS 3       “Data to PC”

   The PiCUS 3 screen shows “Searching for PC (BT – USB)...”

   PC program     “Configuration” → “Select COM port” → Tab “Port PiCUS”

   PC program     Click  to open the COM port. The icon should turn green.

   Click “Test PiCUS 3” button. If the connection works properly the PC program shows the message
   “PiCUS 3 ok”. The PiCUS 3 screen shows “USB <-> PC: ok” or “BT <-> PC: Ok”.

4. Set Calliper and Treetronic COM port

   Enter the PiCUS Calliper BT COM port accordingly.

   Enter Treetronic port – if applicable – accordingly.

   Close window with OK to save settings.

   “GPS” settings are only important if an external GPS receiver is connected to the PC. The PiCUS 3 has an in-built GPS module whose information can be read in the measuring window. See chapter: “Read GPS signal from PiCUS 3”.
5.3 Sonic scan with PiCUS PC program Q73

The workflow for a tomogram scan using Q73 software and the PiCUS 3 is very similar to the previous software and hardware. This description will show the main steps needed to perform a sonic scan.

No special setting needs to be done in the PiCUS 3. Just make sure that the number of sensors (6 or 12) is configured correctly.

In the Q73 PiCUS PC program follow the following procedure:

1. **PC program** Open a new file: “File” → “New” and follow the wizard.
2. **PC program** Enter tree data in menu: “Edit” → “Tree Data”.
3. **PC program** Enter geometry. (See chapter “Geometry in Q72 manual”)
4. **PC program** Open sonic scan window: “Measurement” → “Measure sonic” or click icon:
5. **PC program** In the sonic scan window first set the number of sensors connected to the PiCUS 3; go to tab “Modules” and set “Number of Modules” to 12 (if 12 sensors are connected to the PiCUS 3).
6. **PC program** Adjust the sensor – MP allocation table. “MP Position” is the number of the nail. “Current Pos” is the position of a sensor. The example shows:
   - Sensor 1 is at MP (nail) 1.
   - No sensor is at MP 2.
   - Sensor 2 is at MP 3.
   - No sensor is at MP 4.
   - Sensor 3 is at MP 5.
   - Sensor 4 is at MP6 Etc.
   - When “Calculation immediately” is checked the tomogram is calculated while tapping.
7. **PiCUS 3** “Sonic Tomogram (PC)” → “Connect PC”  
   The PiCUS 3 screen shows  
   “Searching for hammer …” and  
   “Searching for PC (USB – BT)” …”  
   The PiCUS 3 will automatically detect the hammer (PRHD) in cable mode.  
   In radio mode, turn on the hammer to connect it to the PiCUS 3.  
   The PiCUS 3 will also find either USB or Bluetooth connection to the PC automatically. Once both PC and hammer connections are made the system is ready for the sonic scan.
8. **PC program** Clicking to open port. The button should change to .  
   **Attention:** Every time the COM port is changed, for instance from Bluetooth to USB, the port setting needs to be updated. The COM Port can also be changed in the sonic measurement window but changes are not saved.
9. Push either hammer button (> 1 sec) to wake up the hammer. Push hammer buttons to count upwards or downwards until the number matches the MP you intend to tap on.
5.4 Read GPS signal from PiCUS 3

The PiCUS 3 has an in-built GPS receiver that is turned automatically on when the PiCUS is turned on. In stand-alone mode the GPS coordinates are automatically saved to the file. In PC guided mode the GPS signal can be transmitted to the PC through the “Sonic measurement” window of the Q73 software. Proceed as follow:

1. Turn on PiCUS 3 and bring it to PC modus.
   
   **PiCUS 3**
   
   “Sonic Tomogram (PC)” → “Connect PC”

2. PC program
   
   “Measurement” → “Measure sonic” or click icon:

3. PC program
   
   Clicking to open port. The button should change to . The screen of the PiCUS 3 should show “PC <-> USB ok” (or BT ok)

4. PiCUS 3
   
   Activate the hammer by pushing either hammer button. The screen of the PiCUS 3 should show “Radio hammer active” if hammer is in radio modus.

5. PC program
   
   Click the satellite icon to start reading GPS data. The icon changes to:
   
   The readings take a few seconds. The function is turned off automatically. If GPS signals are available the bottom line shows both UTC and coordinates.

   Depending on signal quality the signal acquisition may take up to 5 minutes. The longer the GPS module can read the signal the better is the quality of the coordinates. Therefore it is a good strategy to do the sonic scan and get GPS coordinates afterwards.

   The GPS coordinates are saved to the PiCUS data file and can be found in the tree data window.
6 Charging PiCUS 3

Connect hammer, main unit and charger as shown on the photo to charge the equipment.

On the PiCUS 3 the “charge” LED will show light until charging is done.

The hammer will start to show the circling line when connections are made (middle image). After less than a minute only the dot will remain (right image) and indicate the charging process of the hammer. Once the LED start to show a flashing light every couple of seconds the hammer battery is charged.

**Note:** Do not expose the unit to sunlight when charging! The sun will warm up the device and interfere with the charging temperature control. Charging temperature range is 15° - 25°C.

The battery symbol in the top right corner of the PiCUS 3 screen shows battery status. Meaning:

- ![Battery full](image)
  - Battery full. After charging the battery display shows a voltage larger than 11 Volt.

- ![Battery below 10.0 Volt](image)
  - Battery below 10.0 Volt, PiCUS 3 will work for another 1-3 more hours (depending on usage, temperature, display brightness etc)

- ![Battery below 9.3 Volt](image)
  - Battery below 9.3 Volt, PiCUS 3 will work for some more minutes. Finish work as soon as possible and save the data.

If the hammer in radio operation mode runs out of power during a test leave the sonic scan function. Connect the hammer with the cable to the PiCUS 3 and enter the sonic scan function again. The PiCUS 3 will now power the hammer.
7 Advanced information

7.1 3-Point measurements

Wood is a very anisotropic material regarding the transmission of sonic waves. The speed of sonic waves in trees depends on several parameters. Most of all it depends on:

- Angel between propagation direction of the wave and annual growth rings. The main directions to distinguish between are axial, along the trunk, tangential, along the circumference and radial, through the centre of the tree.
- Moisture content in the different layers of the trunk
- Type of wood, e.g. reaction wood versus “normal” wood.

The arrows in the sketch below show three different ways in which sonic waves travel. Sound in in most trees travels best in a vertical direction (1) – along the grain of the trunk. Regarding the variations in horizontal propagation speed and propagation direction there are two major groups of trees:

SoT type 1: radial velocity (2) is larger than tangential velocity (3)

SoT type 2: radial velocity (2) is lower than tangential velocity (3)

**SoT Type 1**

In SoT Type 1 trees the radial (2) velocity - straight through the middle of the trunk - is higher than the tangential. The graph on the right shows the so called “velocity profile”.

```
Tapping point is MP 5

Sensor, measuring radial velocity
Sensor, measuring tangential velocity
```

Virtually all European tree species belong to this group. Exceptions are palm trees and *taxodium distichum*.

The “3-Point” or “Point to point” test uses this fact as a quick and rough estimate about the wood quality. The 3-Point test measures both radial and tangential velocities at the same time using three test points at the positions six, nine and 12 o’clock. If the “6-to-12” o’clock velocity (red) is slower than the “6-to-3” o’clock velocity (black) then the trunk has major/big (!) structural defects. Smaller defects cannot be located with this test.
7.2 Radio Hammer Operation

The electronic hammer of the PiCUS 3 (PRHD) can be operated with a cable connection to the PiCUS 3 or with a wireless radio connection. The cable connection is more reliable. The radio frequency the hammer is using is a public frequency. For this reason in particular in urban environments the signal will be jam by other users of that frequency.

The tree will cause a kind of radio shadow when it is in-between hammer and PiCUS 3.

The use of the wireless hammer connection for the 3-point test, where the hammer is closed to the receiver in the PiCUS 3, usually works without problems.

**Attention**: in case you want to switch from radio-hammer connection to cable-hammer connection during a measurement because of unreliable radio connection please proceed as follow:

1. Wait until the hammer turns itself off!
2. Terminate the measuring window or leave the PC-connection window, depending on the the operation mode.
3. Disconnect the hammer antenna from the hammer.
4. Connect the hammer cable to both hammer and PiCUS 3.
5. Re-enter the measuring window or re-start the “Sonic Tomogram PC” function.
7.3 Download tree names list to PiCUS 3
The list of tree names that can be loaded into the PiCUS 3 may have 27 entries maximum. The list can be configured on the PC. Proceed as follows:

1. PC program  “Configuration” → “Tree species”
   
   Add tree species to the list.
   
   Remove tree species from the list.
   
   Save list to PC disk.
   
   Select/un-select all
   
   Close that window.

2. PC program  Select the species you want to see in the “tree data” window of the PiCUS Q73 PC program in that list. For this window the number of trees selected is not limited. This list is also the base of the list that can be downloaded to the PiCUS 3. The PiCUS 3 download list can only have 27 entries.

3. PC program  Close the window using “OK” button.

4. PiCUS 3  “Data to PC”
   
   The PiCUS 3 now waiting for BT or USB connection to the PC.

5. PC program  “PiCUS 3” → “Tree species Export”
   
   Number of selected names.
   
   Download to PiCUS 3 button.

6. PC program  Push button “Send tree species” to download the list to PiCUS 3.
   
   The PiCUS 3 confirms the receiving of the file.
7.4 Exporting geometry and tree data to TreeTronic 3

When a sonic tomogram has been recorded prior to the ERT scan the tree data (geometry etc) of the PiCUS 3 can be sent directly to the TreeTronic 3. To do so proceed as follows.

1. Prepare the TreeTronic 3 for receiving data:

   TreeTronic 3 Main menu → “Data connections”.

   The TreeTronic 3 now waits for the serial connection (either BT or USB) to the PC or PiCUS 3.

2. Start the PiCUS 3

   PiCUS 3 Main Menu → “Data connections” → “to TreeTronic”

3. When the geometry data has been received the ERT scan can start. However, in many situations it is recommended to use more MP in the ERT scan than for the SoT. MPs can be added one by one using the menu:

   TreeTronic 3 Main Menu → “ERT” → “Geo Circle” → “Add MP”

   The number of MP can also be doubled if the PiCUS 3 has send a geometry with 12 MP or less.

   TreeTronic 3 Main Menu → “ERT” → “Geo Circle” → “Double MP”
8  Firmware updates of the PiCUS 3

The PiCUS 3 system contains several µControllers. The software for these µControllers is called “firmware”. “In electronic systems and computing, firmware is the combination of persistent memory and program code and data stored in it..." (Wikipedia).

Two of the µControllers may be updated when a new firmware is available.

8.1  How to check the firmware version of the PiCUS 3

The versions of the firmware can be checked in the “update” menu of the PiCUS 3.

PiCUS 3  " Configuration” → “Updates”

When this menu is called the following information is given (example):

“Display Software: 1.1” - The firmware version of the display (screen of the PiCUS 3) is “1.7”

“Hardware: 22” - The PiCUS 3 hardware (the PCB) is “22”. The hardware cannot be updated.

“Firmware: 21” - The version of the internal PiCUS 3 software, called Firmware, is “21”.

From time to time an update of the PiCUS 3 firmware and the display firmware versions may become necessary.

Due to a newer type of the PiCUS CPU which is being used for serial numbers PST3-149 and higher there will be two versions of new firmware.

Firmware for serial numbers PST3-001 to PST3-148 is named: PiCUS3 V21 for 256A3.hex

Firmware for serial numbers PST3-149 to PST3-xxx is named: PiCUS3 V21 for 256A3U.hex

8.1.1  Update of the firmware of the PiCUS 3 main µController

This is the procedure to update the PiCUS 3 firmware. Read the entire list before you start the update.

1. Turn PiCUS 3 OFF.
2. Start PiCUS PC Program.
3. Connect the PiCUS 3 to the PC using the serial cable. Wait for the COM port to be created in case it is the first time this connection is made. Get the COM port number (Device manager). In the example the COM port number is 18.
4. PiCUS program  Select “Configuration” → “Firmware updates” → “PiCUS 3”
5. PiCUS program  Select correct COM port, path and name of the update-file.
6. PiCUS program  Open COM port.

7. PiCUS program  Click download button
8. PiCUS program  Read message and confirm with pressing OK.
9. PiCUS 3  Press ON button and keep it pressed until download is complete.
8.2 Update of the firmware of the PiCUS 3 display

This is the procedure to update the PiCUS 3 display firmware. Read the entire list before you start the update.

Attention: We do your very best guide you smoothly through the update process. However, the update process is done at your own risk.

The update process of the PiCUS 3 display must not be interrupted. Interrupting or cancelling the update will result in a malfunction. The PiCUS 3 must be returned to argus electronic if that happens. It is recommended to terminate all other program (email clients, Windows ® updates etc) on the PC while the display update is done.

1. PC Close all programs that may occupy PC resources (email, internet ...) and start the PiCUS PC program.
2. PiCUS 3 Turn PiCUS 3 ON.
3. PiCUS 3 “Settings” → “Firmware updates” → “display”.
   Display shows “Waiting for connection”.
4. Connect the PiCUS 3 to the PC using the serial cable. Wait for the COM port to be created in case it is the first time this connection is made. Get the COM port number (Device manager). In the example the COM port number is 18.
5. PiCUS program Select “Configuration” → “Firmware updates” → “display”.
6. PiCUS program Select correct COM port, path and name of the update-file.
7. PiCUS program Open COM port.

![Download to PiCUS 3](image)

8. PiCUS program Click download button and wait for the update to finish. **DO NOT interfere with the download.** When the download fails the PiCUS 3 needs to be send to argus electronic for service.
9. Turn PiCUS 3 OFF and ON to complete the update.
9 Technical specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of sonic sensors</td>
<td>6 or 12</td>
</tr>
<tr>
<td>Number of measuring points in autarkic mode</td>
<td>up to 24</td>
</tr>
<tr>
<td>Number of measuring points in PC mode</td>
<td>up to 50</td>
</tr>
<tr>
<td>Length of sensor-cable loom</td>
<td>3,5 m</td>
</tr>
<tr>
<td>Resolution of sonic propagation time measurement</td>
<td>1 µs</td>
</tr>
<tr>
<td>Accuracy of GPS receiver</td>
<td>0 to 20 meter, depending on environment</td>
</tr>
<tr>
<td>Battery capacity of re-chargeable NiMH Battery</td>
<td>2000 mAh</td>
</tr>
<tr>
<td>Nominal battery voltage</td>
<td>10V</td>
</tr>
<tr>
<td>Charging time</td>
<td>approx. 4 hours</td>
</tr>
<tr>
<td>Charging power specification</td>
<td>100/240 VAC, 50/60 Hz</td>
</tr>
<tr>
<td>Time of operation at 20°C, 12 sensors (during setup / sonic scan)</td>
<td>up to 12 / 6 h, depending on usage</td>
</tr>
<tr>
<td>Dimensions of the measuring case</td>
<td>55 x 42 x 13 cm</td>
</tr>
<tr>
<td>Over-all weight (case, PiCUS tomograph, tools, nails)</td>
<td>8,9 kg</td>
</tr>
<tr>
<td>Over-all weight (case, PiCUS tomograph, <strong>PiCUS Calliper 3</strong>, tools, nails)</td>
<td>10,5 kg</td>
</tr>
<tr>
<td>Weight of measuring case</td>
<td>4,8 kg</td>
</tr>
<tr>
<td>Battery capacity of the electronic radio hammer (PRHD)</td>
<td>500 mAh</td>
</tr>
<tr>
<td>Max distance between hammer (PRHD) and PiCUS 3 main unit</td>
<td>0,5 to 10 m, depending on environment</td>
</tr>
</tbody>
</table>
9.1 Maintenance

The operation of the PiCUS Sonic Tomograph does require very few maintenance procedures.

Careful usage is strongly recommended when working with the tomograph. Most important handling or maintenance hints are:

- Do not bend or cut cables.
- Do not tap/hit on the sensors and do not allow them to “jump” to other magnetic materials since they be damaged.
- Dry the unit carefully when it was exposed to wet conditions.
- Do not store it below 0°C or above 45°C
- Make sure the magnets are clean when attaching the sensors to the nails. Never scratch on the magnets!
- Clean hammer-head surface and tapping pin from time to time to make ensure electric contact. On the hammer-head abrasive paper can be used to clean the surface.

- Do not store the tomograph with an empty battery. Charge it to 80-90% prior to periods of inactivity.

The only part that gets older is the battery. The battery should survive several hundred charge-discharge cycles. However, battery life time depends on usage and ambient conditions.

Calibration of the sensors is not required. However, calibration certificates can be issued if needed when the tomograph was inspected in our laboratories.
9.2 Accessories
Common (roofing) nails can be used to couple the sensors to the wood of the tree. The nails need to be long enough to reach through the bark into the wood. Nails need to be magnetic. The nail head diameter must be at least 6 mm. Nail head surface must be flat, so that the magnet of the sensor fits well. The photos below show two types of nails that can be used.

9.3 Spare parts
9.3.1 Battery
The internal PiCUS battery is supplied by argus electronic gmbh. Please do not use other batteries. In case the capacity of the battery goes down send the unit to our laboratories for inspection and battery replacement. Skilled technicians can swap the battery by themselves.
### 9.3.2 Spare parts item numbers

#### Tapping pin and cable

#### PRHD radio antenna

#### PICUS 3 hammer cable

#### Number plates

<table>
<thead>
<tr>
<th>#</th>
<th>Item number</th>
<th>Item name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>901000010</td>
<td>PiCUS 3 battery</td>
</tr>
<tr>
<td>2</td>
<td>100103026</td>
<td>Tapping pin</td>
</tr>
<tr>
<td>3</td>
<td>100103022</td>
<td>Tapping cable</td>
</tr>
<tr>
<td>4</td>
<td>100901035</td>
<td>PRDH radio antenna</td>
</tr>
<tr>
<td>5</td>
<td>900100001</td>
<td>Number plates, numbers 1 to 24</td>
</tr>
<tr>
<td>6</td>
<td>900100038</td>
<td>Number plates, numbers 1 to 30</td>
</tr>
</tbody>
</table>
10 Contact information

argus electronic gmbh
Erich-Schlesinger-Straße 49d
18059 Rostock
Germany

Tel.: +49-381 / 49 68 14 40
email: info@argus-electronic.de
home: www.argus-electronic.de